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1. Legal stuff





KiSS CNF Editor (the Software) is copyrighted freeware. Copyright by Klavdij Voncina. It may be distributed freely and without limitations as long as no fee is charged.


This software is provided ‘as is’. Author cannot be held responsible for any damage occurring from usage of the Software.


KiSSLD is copyrighted to M.Kimura,


PlayFKiSS is copyrighted to Chad Randall, and


WKiSS and WKiSS32 are copyrighted to F.K..


KiSS is copyrighted to K.O.S..


All other products and trademarks mentioned within this document are copyrighted to their legal owners.





Author wishes to thank all programmers for their freeware routines used in this program. Special thanks goes to F. Koshevnikov, I. Pavluk and S. Korolev.


Special thanks to Ross Flack for his suggestions on UI design.





2. Overview





KiSS CNF Editor is a tool to create or modify KiSS configuration files (CNF files).


It is assumed You have at least a basic knowledge of how KiSS works and how the CNF files are built. Please take a look at excellent KiSS documentation including ‘How to make KiSS sets’ walk-through available at BKP (http://otakuworld.com/kiss/) if You are unfamiliar with KiSS making.


KiSS CNF Editor enables You to create CNF files ‘visually’ - by pointing-and-clicking the mouse without having to type  lines of text into the text editor. It makes easier to edit existing CNF files - adding or deleting cels or comment lines, moving lines, editing cel’s properties - all can be done comfortably by using the mouse.





2.1. CNF Editor and CNF files





Note: Information in this chapter considers the way KiSS CNF Editor handles data represented in CNF file and not the rules of building CNF files in general. The terms used are specific to CNF editor.


Following types of  lines are recognized by KiSS CNF Editor:


1. Size line. Form: (xsize,ysize); Example: (640,480)


Size line is set during creation of the new CNF file (see chapter 4.1.) and can be edited later using standard editing methods. The size line cannot be deleted from CNF file using the standard Remove command.


2. Palette line(s). Form: % filename.kcf; Example: % main.kcf


Palette line(s) specifies palette(s) to be used with cels. 16-color and Enhanced color modes supports multiple palettes, 256 color mode allows single 256-color palette, and CKiss color mode requires no palette at all.


3. Cel lines.


The KiSS CNF Editor constructs cel lines using Cel Properties Editor, so You don’t need to now much on how the cel lines are build. For more information on this subject refer to KiSS documentation available on the Internet. (Dov’s BKP - htttp://otakuworld.com/kiss - is a good starting point.)


4. Comments. Form: ;line containing some comment; Example: ;Sets color and position info


Single line containing some comments. Empty lines are threated as comments, too.


5. Set color and object position info. Form: $ color_set_no obj_0_x,obj_0_y, ...;


Example: $0 50,100 * 0,75 ...


These are set by KiSS viewer and cannot be removed or edited using standard CNF Editor’s methods. The only way to create/modify them from within the KiSS CNF Editor is to use the line editbox (unrecommended!!!).


6. FKiSS commands. Form: ;@ FKiSS command; Example: ;@ press(‘button1.cel’)


Lines containing FKiSS commands are threated as comment lines in this version of KiSS CNF Editor as no FKiSS support is build-in (yet). Use comment’s adding and editing methods to add/edit FKISS code.


7. Other.


All other types of lines are threated as other. These include the border color ([) definition, which is more or less unsupported by newer KiSS viewers (on the Windows platforms). Lines categorized as others cannot be edited or removed using standard methods.





The CNF file is build from three main blocks:


1. General information block(header): Contains palette definition(s), screen size, border color (optional).


2. Cel  block: Contains cel definitions.


3. Other (footer): contains sub-block of sets color and object position defining lines and an optional sub-block containing FKiSS code.


All three blocks can also contain additional comment and/or empty lines to improve file’s readability.





2.2. CNF Editor Color modes





Following four color modes are supported by current version of KiSS CNF Editor:


1. 16-color mode (KiSS/GS). This mode allows 16-color palette(s) and cels to be added to the CNF file. It supports multiple palettes. (Up to 17 palette files may be added.)


2. 256-color mode (KiSS/GS). This mode allows 256-color palette and cels to be added. Only one palette file is allowed.


3. Enhanced color mode (advanced). This mode allows mixing of palettes and cels of different types (incl. CKiSS cels). It also allows multiple palettes. Warning : This feature is not generally supported by KiSS viewing programs. Newer versions should support it but older versions will probably malfunction. Use this feature with care.


4. CKiSS mode. This mode allows building of True color KiSS data sets. As color information is included in CKiSS cel itself no palette files are needed.





2.3. The status bar





The status bar has three sections displaying some basic information on KiSS CNF Editor’s current working mode and options.Theese are:


1. Color mode.


2. Insertion mode. Possible values are: TOP (Add to Top), BTTM (Add to Bottom), FRNT (In Front of Selected Line), and BHND (Behind Selected Line).


3. Full path to working directory. (For example C:\kiss\KiSSset1.)





3. Brief overview of menu commands





Project menu





New - choose this option to start creating new configuration file from scratch. A simple wizard will guide You through the new CNF file creation process.


Open - brings up the file requester and then loads the selected CNF file to memory. Once loaded the CNF file listing appears in the list box in the left part of the screen.


Save - saves the file under existing name. If file hasn’t been given a name yet (NoName.CNF) the file requester appears enabling You to choose a name for the file.


Save As -  saves the file with the new name.


Store - stores current CNF file to memory making it possible to restore it later using the


Restore option.


Convert - this command converts selected file to use CR/LF combination of characters to split lines. The KiSS CNF Editor is rather picky when comes to line delimiting. The CR/LF (ASCII code of 13 and 10) is the only line delimiter recognized. If CNF file uses different character as line delimiter it won’t be loaded properly. Some KiSS viewers (16bit version of WKiSS, for example) and some text editors are using other character combinations (CR,LF/CR) to split the lines. If You want to edit these files using the KiSS CNF Editor, You’ll have to convert them first. Converting won’t affect the CNF files in any other way but swapping the line-breaking characters, i.e. CNF files should still be readable by all KiSS viewers.


To convert a CNF file select Project-Convert option. The file requester dialogue will appear enabling You to select the file to convert. Once converted the file is saved back to disc using the same name.


Locate External Viewer - brings up the dialog to set the KiSS viewing program to be used as an external viewer. (See chapter 4.5.2. for more information on this subject.)


Exit - quits the program.





Edit menu





Add palette - adds new palette to the CNF file. This option is available when in 16-color or Enhanced Color mode, only. For more information see chapter 4.2. .


Insert Cel - inserts new cel to the CNF file using Cel properties Editor. For more information see chapter 4.4. .


Insert Comment - inserts new comment line to the CNF file using Edit Comment dialog box.


Insert Line - inserts empty line to the CNF file and switches focus to Edit Line box enabling You to add text manually. See chapter 5.6. for more information.


Edit - invokes appropriate editor window(if available) for the selected line.


Remove Line - removes selected line.


Remove Object - removes object. Refer to chapter 5.3. for more information.


Change to Enhanced Mode - changes CNF color mode to enhanced. This option is only available when working in 16-color or 256-color mode. See chapter 2.2. for more information on Enhanced mode.


Insertion Mode - this sub-menu determines where the new lines are to be added. See chapter 4.7. for more information.





Move menu





Commands to move lines are contained in this menu. Please refer to chapter 5.1. for more information on moving lines.





Search menu





Find  -  bring up text search window enabling You to search through the CNF file for occurrences of selected text.


Find Next - finds the next occurrence of the text selected by Find option.





4. Creating new configuration file





4.1. Using the Wizard to create new CNF file


 


Let’s start creating a CNF file from scratch. First select New from the Project menu or click then New button on the tool bar. Simple wizard is invoked guiding You through the CNF file creation process. This process includes three steps:


1. Working directory. All files needed by the CNF file (cel,kcf,wav,mid...) must reside in the same directory. Selected this directory by either entering its name into the edit box  or by browsing the disc using the Browse disc button. Click on Next button when done. Note: You cannot move to next step if directory given does not exist.


2. Screen size. Select screen size from presets drop-down list or enter it manually by selecting ‘Custom’ option from drop-down list and entering its size using spin edit boxes.


3. Color mode and initial palette. Select appropriate color mode from radio group. For more info on available color modes please refer to chapter 2.2. . You must also select initial palette unless CKiSS color mode is selected. If first option (16-color or 256-color mode...) is selected the actual color mode is determined by initial palette color mode.


When done click Finish to complete initialization of new CNF file. Now You are ready to edit it using either menu commands, tool bar buttons or Line Edit box.





4.2. Adding palette(s) 





Important(doesn’t apply for CKiSS mode): You have to add at least one palette file to the CNF  before You are able to add cels. If added palette is a 16-colors one the multi palette mode (16-color mode) is activated allowing You to add up to 17 16-colors palettes to the CNF. When a 256-colors palette is chosen the multi-palette mode is disabled. Also, adding a 256-colors palette when in multi- palette mode will generate an error.


Adding a palette.


Use the Edit - Add Palette menu option (or click appropriate button on the tool bar) to add new palette to the CNF file. (Note: This option is only available when in 16-color or Enhanced color mode.) This will bring up the Palette Line Editor window allowing You to select a palette from a drop-down listbox containing all the palette files available in current working directory. 


Now, You may continue adding palette files if You are creating a multi-palette KiSS set or proceed to adding objects and cels.





4.3. Adding and editing objects





The object is a basic unit of KiSS set. It consists of one or more cels sharing same co-ordinates and fix value. For example body as object could consist of cels representing head, hair, arms, legs, and torso. Each objects has its own ID number, position and fix value. ID number, fix value and an optional comment making it easier to differentiate between objects can be changed from within the KiSS CNF Editor.


Editing existing object. There are two ways to edit an existing object:


1. Select an object from Object List box and click the right mouse button to bring up the pop-up menu. Now select the Edit option. You may also double-click the desired object’s entry in the object listbox.


2. You may also edit existing object from the Cel Properties window by selecting object to be edited from Object drop-down list and clicking the Edit Object button next to it.   


In both cases the Edit Object dialog box is invoked. This dialog box has three fields to enter the object ID number (which is enabled only when adding new object), the optional comment, and object’s fix value (ranging from 0 to 32676). Leave the fix value as is (don’t lock objects before You’ve placed them on screen using KiSS viewer) and enter descriptive object name in the comment text edit box (body, for example) if You wish.


Adding new object. You can add new object using the Object list (main window) pop-up menu (the New option) or from Cel Properties window using the New Object button.


In both cases the Object’s properties dialogue box appears. Accept suggested ID number or enter Your own (ranging from 0 to 255). Add the descriptive name in comment edit box and then leave dialogue box by clicking the OK button or by pressing <Return> key. Presuming the object ID number is 1 and it’s name is ‘underwear 1’ and fix value is 0, line reading ‘1.0 underwear 1’ should appear in the objects list box.


Note: Maximum number of objects allowed by this version of KiSS CNF Editor is 256.





4.4 Adding cels





Select Edit - Insert Cel option from the menu to insert new cel. When done You’re taken to the Cel properties editor.





4.4.1. Cel Properties Editor





The Object drop-down list allows You to choose the object You wish to associate edited cel to. All objects entered in the Objects sheet are available to choose from.


You may edit/add objects by using the Edit Object and New Object buttons.


The Cel drop-down list enables You to select a cel to be used. Note: Only the cels contained in current working directory are available.


The Palette drop-down list allows You to choose the palette to use with cel (when working with multi-palette KiSS sets). Please check the cel preview window to make sure You’ve chosen the correct palette. All palettes appearing in the CNF file are available to choose from.


Note: If the selected cel is of true color (CKiSS) type the Palette drop-down list is disabled.


The Sets check-boxes: the cel will appear only in sets which check-boxes are checked. Click on Check All button to make all sets active. Click on Clear All button to clear all check-boxes.


Enter the optional cel line comment (up to 80 characters) in the Comment edit box.


Use the Transparency edit box to set objects transparency using the ;%t000 format (not supported by all KiSS viewers).


Clicking OK button returns You to the main window adding cel line to the CNF  file.





4.5. Positioning cels on the screen





External KiSS viewer (PlayFKiSS, KiSSLD, WKiSS, WKiSS32 ...) is required to position cels (objects) on the screen. You may run KiSS viewer from within the KiSS CNF Editor by clicking the Viewer button (this option is discussed in detail later) or by running both KiSS CNF Editor and KiSS viewer simultaneously switching between them using standard Win95 methods. Please consult Your Windows 95 manual if You don’t know how to run several programs at the same time and to switch between them at run-time.


When using the latter method proceed as follows:


1. Make sure both programs are running.


2. When done with adding palette(s), objects, and cels to the CNF file in the KiSS CNF  Editor save the resulting configuration file using Save or Save As option from Project Menu.


3. Switch to the KiSS viewer and open the CNF file You saved in 2..


4. Position the cels and then save the KiSS set using the same CNF filename.


5. Switch back to KiSS CNF Editor and re-load the CNF file using  Projects/Open. (Don’t forget to convert the CNF file prior to re-opening it if You’re using the 16-bit version of WKiSS as Your KiSS viewer.)





4.5.1. Configuring external KiSS viewer





Of the programs I checked PlayFKiSS and KiSSLD are suitable to use as an external viewers while both WKiSS and WKiSS32 reports errors when started as external viewers.


To configure the external viewer use the File - Locate External Viewer option from the main menu. Enter KiSS viewer full directory path and name (C:\PlayFKiSS\PlayFKiSS.exe, for example) or browse the disc for KiSS viewer by clicking the button to the right. If You are going to use KiSS viewer which doesn’t use CR/LF combination to mark the end-of-line check the Convert CNF file check-box.





4.5.2 Using the external viewer





Once configured You can switch to the selected KiSS viewer by clicking on the Viewer button. The KiSS CNF Editor window is closed, current CNF file is saved to disc (the file requester appears if CNF filename hasn’t been chosen yet), KiSS viewer is started and current CNF file is loaded to it. Now You can place the cels. When done save the set by using viewer’s Save File option. Make sure You save the CNF file using the name given in the KiSS CNF Editor. Now close the KiSS viewer to return to the CNF Editor’s main window. If You don’t want to keep the changes close the viewer without saving the KiSS set.





4.6. Locking objects





When objects are positioned within the screen they may be locked if necessary. To lock the object (and all cels associated to it as well) use the either of the Edit Object methods described in chapter 4.3.. Enter the desired fix value in the appropriate edit box and click the OK button.





4.7. Adding comment lines





Use Edit - Insert Comment to add single comment line to the CNF file. The Edit - Insertion mode sub-menu determines where the new comment line is added:


Add to Top: adds the comment to top of the file


Add to Bottom: adds the comment to the bottom of the file


Insert before Selected: inserts comment before selected line (If no line is selected the comment is added to the top of the file)


Insert after Selected: inserts comment after selected line ( or  to the bottom of file if no line is selected)


(Same rules apply when adding cel lines except that cel lines are added to the top/bottom of cel list part of CNF file rather then to top/bottom of the whole file. Cel lines also cannot be placed outside the cel list block so if selected line lies outside the cel block the cel is inserted to the top or the bottom of the cel block as appropriate no matter which option is selected in the Insertion mode sub-menu. )








4.8. Notes on FKiSS





The FKiSS programming isn’t directly supported by KiSS CNF Editor. You may however add the FKiSS commands by using the methods to add comments starting them with the ‘@’ character.





5 Quick notes on editing





5.1. Moving lines





Only cel and comment lines are moveable. Use the Move menu options (To Top, One Up, One Down, To Bottom)  to move lines up or down. Cel lines cannot be moved outside the cel list part of the CNF file. Move cel lines to change cel’s order of appearance in the Kiss data set. (Remember, the top most cel in the CNF file appears on top of all other cels in the Kiss data set, the cel at the bottom of the CNF file appears behind all other cels in Kiss set.)





5.2. Removing lines





Use the Edit - Remove line or the appropriate button form the tool bar to remove selected line. Lines containing set’s information (starting with ‘$’ sign), screen size and lines unknown to Kiss CNF Editor cannot be removed.


Removing palette entries is possible but is not advisable if the palette is being used. However, the last palette entry can’t be removed.





5.3. Removing objects





Select object to be removed from the object list box and select Edit - Remove Object from the  main menu. Be warned though - all cels associated to the selected object will be removed from the CNF file as well.





5.4. Disabling cels





If You wish to prevent certain cels from appearing in the Kiss data set without removing them from CNF file permanently proceed as follows (thanks to Chad Randall and Maxfield Stanton for bringing this up at KiSSML):


1. Select cel to be disabled and bring up the Cel Properties Editor by either clicking the Edit button or by double-clicking it.


2. Click on the Clear All button to clear all set check-boxes.


3. Click OK button to return to the main window.


Something like ‘#10.20           risque.cel :’ should appear in the CNF list box. The cel is still listed in the CNF file but won’t appear in the Kiss set when viewed using Kiss viewing program. This should work with majority if not all Kiss viewers.


To re-enable the cel check some set check-boxes in the Cel properties editor. 





5.5. General notes on editing lines





Lines containing set information (starting with ‘$’ sign) and lines unknown to KiSS CNF Editor (border color, memory size, future extensions) cannot be edited from within the KiSS CNF Editor using standard Edit option. To edit other types of lines highlight line to be edited and then select Edit - Edit option from the main menu or double-click the line to be edited to bring up appropriate edit window.





5.6. Line Edit box (new in v1.1)





Line Edit box (positioned under the CNF List box) is a replacement to the Edit Raw option introduced with version 1.01 of KiSS CNF Editor. It enables You to edit each line as raw text. Each line selected from the CNF List box is automatically copied to the Line Edit box and can be edited using standard Win95 methods. When in CNF List box You may also use the F5 shortcut to switch control to the Line Edit box.


You may also use the Line Edit box in combination with Edit - Insert Line option to add new lines to the CNF file. When done with editing press the <Return> key to accept changes and return to the CNF List box or <Escape> to return focus to the CNF List box without accepting changes.


Caution: No syntax-checking is performed on entered text so be careful. Don’t use this tool if You don’t know what are You doing. Wrong entries my crash KiSS CNF Editor, Your favorite KiSS viewing program, or cause Your KiSS set to malfunction.





5.6.1. Commenting and un-commenting





You can use Line Edit box to comment/un-comment cel lines thus removing/adding  them temporarily from/to the KiSS data set. Select the cel to be removed/added back and switch control to the Line Edit box(use standard Win95 methods -Tab key or mouse - or the F5 key). Now add/remove the ‘;’ character at the beginning of the line to comment/uncomment selected line and press <Return> to accept changes.





5.7. Looking-up cels using Object’s cel(s) list





Object’s cel(s) list is a listbox located under the object listbox. Each time new object is selected in the object listbox (or new cel line is selected in the CNF file listbox) all cels associated with the given object are listed in the object’s cel list. Now, You can single-click cel’s entry to look-up its position in the CNF file, or double-click it to bring up the Cel properties editor.


